# Table of Contents

**Introduction** ................................................................................................................................ 5
**General** ........................................................................................................................................... 5
**Introduction** ..................................................................................................................................... 6
**Starting the CCV Alarm Reporter** ....................................................................................................... 7
**Select Profile** ....................................................................................................................................... 7

**Administering Alarm Reporter** ......................................................................................................... 9
**Configuration Pane** .............................................................................................................................. 9
  - Days Tab ......................................................................................................................................... 9
  - Device Types Tab .............................................................................................................................. 9
  - Alarm States Tab .............................................................................................................................. 10
  - Alarm Levels .................................................................................................................................... 11
**Dn List Pane** ....................................................................................................................................... 11
  - Sort Dn List ................................................................................................................................... 11
  - Refresh Dn List ............................................................................................................................... 11
**Report Pane** ....................................................................................................................................... 12
  - Select a Report ............................................................................................................................... 12
  - Breakdown Report .......................................................................................................................... 12
  - Summary Report .............................................................................................................................. 12
  - Sort Reports .................................................................................................................................. 13
  - Refresh Report ............................................................................................................................... 13
  - Preview/Print Report ....................................................................................................................... 13
**Toolbar Commands** ............................................................................................................................ 14
**Menu Options** ................................................................................................................................... 15
  - File Menu ....................................................................................................................................... 15
  - Options Menu ................................................................................................................................. 15
  - Setup Menu .................................................................................................................................... 15
  - Report Menu .................................................................................................................................. 15

**Index** ............................................................................................................................................... 16
Introduction

General
Compact Contact Center (CCC) modules provide the user with the necessary tools to facilitate the management of call traffic. They are designed to provide a tightly integrated real time and historic reporting package and wallboard support for the eBusiness digital communications platform. The product consists of a set of fully integrated modules sharing a common database utilising Interactive Directory and Database (IDD) technology.

The suite of modules consists of the following applications:

- **Call Center View (CCV)**
  Provides a management package for telephone based staff and supports any size Customer Facing Department (CFD) or contact center. To effectively control customer service levels, real time human resource management is essential and the Call Center View has been specially designed to manage the CFD's or contact center's most valuable and expensive asset – it's people.

- **Call Center View Alarm Reporter**
  Provides information (for each Contact Center Profile) about alarms that have occurred within the Compact Contact Center. The detailed alarm information for each directory number is presented in report format, which can then be printed.

- **Wallboard Manager**
  Real time information from the call centre is essential to react to constantly changing telephone traffic levels and provide excellent customer service. Wallboards allow managers and staff to monitor the service being provided and respond immediately. Wallboards provide current information on the number of calls waiting, response times and service levels. Wallboard Manager provides the ability to drive physical wallboards and PC wallboards.

- **PC Wallboard**
  The PC Wallboard delivers traditional wall mounted wallboard functionality to the desktop but with the additional benefit of each PC Wallboard agent being able to configure and monitor a personalised view of the contact center. The PC Wallboard also enables agents to increase their productivity and maintain revenue levels with the added benefit of managing customer callback requests.

- **Reporter**
  This module provides in depth historical reporting on contact center activity. In addition to call information, the Reporter also reports on agent activity. This powerful package allows individual call records to be stored and reported upon months later.

- **CCC User Access**
  CCC User Access allows storage of personal Call Center View and Wallboard settings. It also establishes user rights and password protection for Call Center View, Wallboard and Alarm Reporter software.

- **Workforce Management – Blue Pumpkin**
  Workforce Management Interface allows integrated rostering, forecasting and scheduling systems to connect across the LAN to a comma separated variable (CSV) file containing a list of Contact Center related metrics.

- **Multimedia Module**
  MultiMedia Module (MMM), is a customer contact software solution that enables companies and departments to manage multimedia contacts into and out of the organization. MMM provides applications that manage Telephony, Web Chat, E-mail and Web Call Back communications. For installation of MultiMedia Module, refer to the separate Installation Manual.

For installation and administration of the MultiMedia Module, refer to the separate set of manuals for MultiMedia.
Introduction
The Call Center View Alarm Reporter is designed to enhance the exception management used by Call Center View. The Alarm Reporter allows the contact centre supervisor to look back on the performance of the contact centre, on a daily or weekly basis, by reporting on certain criteria predefined by the contact centre supervisor.

To view the alarm reports you must be logged onto CCC User Access with Administrator Access Level. As an Administrator, historic alarm reports for the profiles that you have created within the Call Center View are viewed for the previous 7 days. The historic alarm information is available to view for each profile. Profiles are analyzed one at a time.

To obtain an historic alarm report file you must ensure that the relevant option is selected within the Alarm Setup options on the Call Center View application. These alarms are reported on a weekly basis for each profile. There is a separate file for each day of the week. The Call Center View will overwrite an existing file for the current day.

There are two types of reports:

- Breakdown Report displays detailed analysis of the alarm information for the selected directory number;
- Summary Report displays a top-level overview of the historic alarm information for the selected directory number.

Each report can be previewed prior to printing in either landscape or portrait orientation. The Report Preview is not dependent upon any printer drivers being installed on the PC. However, if a printer driver is not installed, the print facilities of the application will be disabled.

The title of the report signifies the type of report, i.e. Breakdown or Summary. The report also displays the date and time that the data contained in the table was generated along with the User name and the Call Center View Profile Name.
Starting the CCV Alarm Reporter

Before starting the Call Center View Alarm Reporter, you must ensure that you have enabled the CCC User Access with Administrator rights.

To Start CCV Alarm reporter:

1. Ensure that CCC User Access is running.
2. Click the Start button on the Windows Taskbar.
3. Point to Programs and then to CCC.
4. Click CCV Alarm Reporter from the sub-menu.

The screen is divided into three sections:

- **Configuration Pane**: The view in this pane will vary, depending which tab is selected. Each tab allows you to select different options.
- **DN List Pane**: In this pane you can view the directory numbers for which historic alarm information can be reported.
- **Report Pane**: Displays a report of historic alarm information for a selected directory number.

Select Profile

If there is no information showing in the DN list, make sure that a profile (page 15) has been selected.

**Note**: Alarms must have been set and triggered by the selected profile in Call Center View.
Administering Alarm Reporter

Configuration Pane
The alarms are reported on a weekly basis for each profile. There is a separate file for each day of the week. An existing file for the current day will be overwritten by the Contact Center View, therefore allowing a 7-day look-back in detail. The configuration pane view will change depending upon which tab is selected e.g. Days, Device Types, Alarm States or Alarm Levels.

Days Tab
This is divided into seven days, Monday to Sunday. Click to select the required day(s).

Device Types Tab
Click to select the required Device Type(s) from the listing.
Alarm States Tab
Click to select the required state(s). The Alarm States are received from the CCV.

- **Calls Waiting**: The total number of calls waiting for the agent.
- **Longest Wait**: The length of the current longest waiting calls for this group.
- **Lost Calls**: Incoming calls to an agent/group that are lost or abandoned by the caller.
- **PCA**: (Percentage Calls Answered) The number of calls answered by the group within the target answer time expressed as a percentage of calls answered by the group.
- **Average Answer**: The average call answer time.
- **Overflowed Calls To**: The number of calls which originally rang another directory number then rang this group and were answered.
- **Overflow Calls From**: Calls that originally rang the group and then rang a subsequent group.
- **Call Rate**: The hourly call rate for calls made.
- **Available Agents**: The number of agents who are available.
- **Available Trunks**: The number of trunks that are available.
- **Incoming**: The number of agents currently engaged on incoming calls.
- **Outgoing**: The number of agents currently engaged on outgoing calls.
- **Ready**: The number of agents currently ready to take incoming calls.
- **Holding**: The number of agents currently holding calls.
- **Busy WrapUp**: The number of agents currently in busy wrap up.
- **Busy NA**: The number of agents currently in busy not available.
- **Busy**: The number of agents currently in busy.
- **Logged Off**: The number of agents currently logged off.
- **Ringing**: The number of agents whose extension is currently ringing.
- **Internal Made**: The number of agents currently making internal calls.
- **Internal Received**: The number of agents currently receiving internal calls.
Alarm Levels
The alarm levels fall into two groups either Low or High. Each group has three types; Normal, Caution and Critical.

The settings for the alarm levels are set within the Call Center View program. For more information about alarm levels refer to the Call Center View user Manual.

Dn List Pane
All the directory numbers for the selected configuration are displayed within this pane, as well as the Device Type, i.e. Agents, Trunks groups etc.

There are four icons to symbolize each device type.

- Agents
- Agent Groups
- Trunks
- Trunk Groups

The directory numbers can be viewed in four modes. The default setting is Details. Click the required view button to change the setting:

- Details
- Small Icons
- List
- Large Icons

The display can also be changed by selecting DN List Views from the Options menu.

Sort Dn List
The directory number information can be sorted in ascending or descending order. If the directory numbers are displayed in Details View mode, click the column title to change the sort to either ascending or descending order.

You can also sort the information by:

1. Choose Sort DN List from the Options Menu. You can click the Sort button from the toolbar.
2. From the Sort Dn List screen select the required Sort By option. You can sort the Dn List by Dn, Name or Device Type.
3. Select the Sort Direction, i.e. Ascending or Descending and OK.

Refresh Dn List
To receive updated alarm information for selected directory numbers, you need to refresh the information. To do this:

Select Refresh from the Reports Menu or click the Refresh button.
Report Pane
When a directory number is selected, a report of historic alarm information is displayed in the Report Pane. There is a short delay before the report is displayed, to allow you to select a different directory number. The report information depends upon the Report Type that you have selected, i.e. Breakdown or Summary.

Select a Report
Select the type of report you want by:

1. Select **Type** from the Report menu or click the Report button.
2. Click either **Breakdown** or **Summary** to select the report type.

Breakdown Report
This report is the default report and will show when you first start the program. It provides detailed analysis of the alarm information for the selected directory number.

The report shows the following information:

- **Alarm**: Selected Alarm state(s).
- **Level**: Alarm Levels.
- **Threshold**: The alarm threshold specified within the CCV.
- **Start Time**: Day and Time when the alarm occurred.
- **Clear Time**: Day and Time when the alarm has been cleared within the Switch.
- **Acknowledged**: Time and Day when the supervisor has acknowledged the alarm within the CCV.

Summary Report
This report displays an outline of the historic alarm information. The report shows the following information:

- **Alarm**: Selected Alarm state(s).
- **Total**: Total number of alarm occurrence for a specific alarm state.
- **Avg Duration**: Average duration of a specific alarm state.
- **Max Duration**: Maximum duration of a specific alarm state.
Sort Reports
Either of the reports can be sorted in ascending or descending order. You can only sort the report that is showing in the report pane. To sort the report on screen:

1. Click the required column title to be sorted. It will be sorted into either ascending or descending order.

   or

   Select Sort from the Report menu,

   or

   Click the Sort button on the toolbar.

2. From the Sort Report screen select what you want to sort by. The options are dependent upon whether you are creating a breakdown or summary report.
   
   - **Breakdown Report** - Alarm, Level or Start Time, Clear Time or Acknowledged.
   - **Summary Report** - Alarm, Total, Avg Duration, or Max Duration.

3. Select the Sort Direction, ie. Ascending or Descending and then Click **OK**.

Refresh Report
To receive updated alarm information for selected directory numbers, you need to refresh the information. To do this:

1. Select **Refresh** from the Reports Menu

   OR

   click the Refresh button

Preview/Print Report
The Report Preview is enabled once an alarm information report is being displayed in the Report Pane. Each report type can be previewed in either landscape or portrait orientation. The Report Preview is not dependent upon any printer drivers being installed on the PC. However, if a printer driver is not installed, the print facilities of the application will be disabled.

The title of the report shows the type of report, eg. Breakdown or Summary. The report also displays the date and time that the data contained in the table was generated along with the CCC User name and the CCV Profile Name.

To preview a report, from, **File** menu select **Report Preview** or click
Toolbar Commands
The Toolbar command buttons are also available from the menu bar:

- **Show/Hide Selection Pane**
  These buttons allow you to toggle between whether to display or not to display the Selection Pane. The Selection Pane consists of the Configuration and DN List panes.
  - **Show Selection Pane.**
  - **Hide Selection Pane.**

- **Profile**
  Allows you to select a different profile name.

- **Print Report**
  Allows you to print a report.

- **Report Preview**
  Allows you to preview a report prior to printing.

- **Report Type**
  Allows you to select either a Breakdown or a Summary Report.

- **Sort**
  Allows you to sort either the information displayed in the Dn List pane or the report pane.

- **Refresh**
  Enables you to obtain an up to date alarm information either within the Dn List pane or the Report Pane.

- **View buttons**
  These allow you to select the mode in which the directory numbers are displayed. The default view is Detail.
  - **Detail View**
  - **List View**
  - **Small Icon View**
  - **Large Icon View**
Menu Options

File Menu
The File menu incorporates the following options:

- **Report Preview**: Enables you to preview the report prior to printing. This option is enabled only when a report is being displayed within the Report Pane.
- **Print Report**: Enables you to print a report.
- **Selection Pane**: Enables you to toggle between whether to display or not to display the Selection Pane. When the command has a check mark next to it, the Selection Pane is displayed.
- **Profile**: Enables you to select a different CCV Profile Name. The Select Profile screen appears. This lists only the profiles that have been created by the currently logged on Administrator. If more than one profile is available, select the required one and then click **OK**.
- **Exit**: Enables you to exit the CCV Alarm Reporter.

Options Menu
The Options menu incorporates the following options:

- **DN List View**: Enables you to select the way the directory numbers are displayed. Select one of the following commands: Large Icons, Small Icons, List and Details. Experiment to find the view you prefer.
- **Sort Dn List**: Enables you to sort the items by Dn, Name and Device Type.
- **Refresh Dn List**: Updates the DN List alarm information.

Setup Menu
Setup menu incorporates the following options:

- **Language**: Enables you to select the required language. The Alarm Reporter will automatically change to the selected language.

Report Menu
The Report menu incorporates the following options:

- **Type**: From a sub-menu choose either breakdown or summary report.
  - **Breakdown**: This is the default setting, displaying the alarm information for the selected directory number. The alarm details displayed are Alarm; Level; Threshold; Start Time; Clear Time and Acknowledged.
  - **Summary**: This displays an outline of the historic alarm information. The alarm details displayed are Alarm States; Total number of the alarm; Average Duration for each alarm; Maximum Duration of each alarm.
- **Sort**: Enables you to sort the report items by the appropriate column. This option is enabled when there is a report being displayed for a selected directory number.
- **Refresh**: Updates the alarm information for the selected directory number. This option is enabled when there is a report being displayed for a selected directory number.
Index

A
Alarm Levels ..............................................................................................................................................................11
Alarm Reporter .............................................................................................................................................................6
Alarm States Tab ........................................................................................................................................................10

C
CCV Alarm Reporter
  Starting .................................................................................................................................................................7
CCV Alarm Reporter ..............................................................................................................................................7
Commands ...............................................................................................................................................................14

D
Days Tab .................................................................................................................................................................9
Device Types Tab ..................................................................................................................................................9

G
General ......................................................................................................................................................................5

I
Introduction ..............................................................................................................................................................5, 6

O
Options Menu ..........................................................................................................................................................15

P
Preview/Print Report ................................................................................................................................................13

R
Refresh Dn List ........................................................................................................................................................11
Refresh Report ........................................................................................................................................................13
Report
  Select ....................................................................................................................................................................12
Report ....................................................................................................................................................................12
Report Menu ..........................................................................................................................................................15

S
Select
  Report ....................................................................................................................................................................12
Select .......................................................................................................................................................................12
Setup Menu ............................................................................................................................................................15
Sort Dn List ............................................................................................................................................................11
Sort Reports ...........................................................................................................................................................13
Starting
  CCV Alarm Reporter ..........................................................................................................................................7
Starting ....................................................................................................................................................................7
Performance figures and data quoted in this document are typical, and must be specifically confirmed in writing by Avaya before they become applicable to any particular order or contract. The company reserves the right to make alterations or amendments to the detailed specifications at its discretion. The publication of information in this document does not imply freedom from patent or other protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered to Lucent Technologies have been transferred or licensed to Avaya. All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

This document contains proprietary information of Avaya and is not to be disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to "wgctechpubs@avaya.com".

© 2005 Avaya Inc. All rights reserved.

Avaya
Sterling Court
15 - 21 Mundells
Welwyn Garden City
Hertfordshire
AL7 1LZ
England
Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933
Web: http://www.avaya.com